


Introduction
Excel 2016 All-in-One For Dummies brings together plain
and simple information on using all aspects of the latest-
and-greatest version of Microsoft Excel. It’s designed to
be of help no matter how much or how little experience
you have with the program. As the preeminent
spreadsheet and data analysis software for all sorts of
computing devices running Windows 7, 8, or 10
(desktops, laptops, tablet PCs and even smartphones),
Excel 2016 offers its users seemingly unlimited
capabilities too often masked in technical jargon and
obscured by explanations only a software engineer could
love. On top of that, many of the publications that
purport to give you the lowdown on using Excel are quite
clear on how to use particular features without giving
you a clue as to why you would want to go to all the
trouble.
The truth is that understanding how to use the
abundance of features offered by Excel 2016 is only half
the battle, at best. The other half of the battle is to
understand how these features can benefit you in your
work; in other words, “what’s in it for you.” I have
endeavored to cover both the “how to” and “so what”
aspects in all my discussions of Excel features, being as
clear as possible and using as little tech-speak as
possible.
Fortunately, Excel 2016 is well worth the effort to get to
know because it’s definitely one of the best data-
processing and analysis tools that has ever come along.
Its Quick Analysis tool, Office Add-ins, Flash Fill, and
Recommended Charts and PivotTables, along with the
tried-and-true Live Preview feature and tons of ready-
made galleries, make this version of the program the



easiest to use ever. In short, Excel 2016 is a blast to use
when you know what you’re doing, and my great hope is
that this “fun” aspect of using the program comes
through on every page (or, at least, every other page).

About This Book
As the name states, Excel 2016 All-in-One For Dummies
is a reference. (Whether you keep it on your desk or use
it to prop up your desk is your business.) This means that
although the chapters in each book are laid out in a
logical order, each stands on its own ready for you to dig
into the information at any point.
As much as possible, I have endeavored to make the
topics within each book and chapter stand on their own.
When there’s just no way around relying on some
information that’s discussed elsewhere, I include a cross-
reference that gives you the chapter and verse (actually
the book and chapter) for where you can find that
related information if you’re of a mind to.
Use the full Table of Contents and Index to look up the
topic of the hour and find out exactly where it is in this
compilation of Excel information. You’ll find that
although most topics are introduced in a conversational
manner, I don’t waste much time cutting to the chase by
laying down the main principles at work (usually in
bulleted form) followed by the hard reality of how you do
the deed (as numbered steps).

Foolish Assumptions
I’m only going to make one foolish assumption about
you, and that is that you have some need to use
Microsoft Excel 2016 in your work or studies. If pushed,



I further guess that you aren’t particularly interested in
knowing Excel at an expert level but are terribly
motivated to find out how to do the stuff you need to get
done. If that’s the case, this is definitely the book for you.
Fortunately, even if you happen to be one of those
newcomers who’s highly motivated to become the
company’s resident spreadsheet guru, you’ve still come
to the right place.
As far as your hardware and software go, I’m assuming
that you already have Excel 2016 (usually as part of
Microsoft Office 2016) installed on your computing
device, using a standard home or business installation
running under either Windows 7, 8, or 10. I’m not
assuming, however, that when you’re using Excel 2016
that you’re sitting in front of a large screen monitor and
making cell entries and command selections with a
physical keyboard or connected mouse. With the
introduction of Microsoft’s Surface 3 tablet for Windows
8 and 10 and the support for a whole slew of different
Windows tablets, you may well be entering data and
selecting commands with your finger or stylus using the
Windows Touch keyboard and Touch pointer.

 To deal with the differences between using Excel
2016 on a standard desktop or laptop computer with
access only to a physical keyboard and mouse and a
touchscreen tablet or smartphone environment with
access only to the virtual Touch keyboard, I’ve
outlined the touchscreen equivalents to common
commands you find throughout the text such as
“click,” “double-click,” “drag,” and so forth in the
section that explains selecting by touch in Book I,
Chapter 1.



Keep in mind that all the figures in this book were
created with Excel 2016 happily running on Windows 10
so that you will see the occasional Windows 10 dialog
box and desktop in figures depicting Excel files being
opened and saved.

 This book is intended only for users of Microsoft
Office Excel 2016! Because of the diversity of the
devices that Excel 2016 runs on and the places
where its files can be saved and used, if you’re using
Excel 2007 or Excel 2010 for Windows, much of the
file-related information in this book may only confuse
and confound you. If you’re still using a version prior
to Excel 2007, which introduced the Ribbon
interface, this edition will be of no use to you
because your version of the program works nothing
like the 2016 version this book describes.



How This Book Is
Organized

Excel 2016 All-in-One For Dummies is actually eight
smaller books rolled into one. That way, you can go after
the stuff in the particular book that really interests you
at the time, putting all the rest of the material aside until
you need to have a look at it. Each book in the volume
consists of two or more chapters consisting of all the
basic information you should need in dealing with that
particular component or aspect of Excel.
In case you’re the least bit curious, here’s the lowdown
on each of the eight books and what you can expect to
find there.

Book I: Excel Basics
This book is for those of you who’ve never had a formal
introduction to the program’s basic workings. Chapter 1
covers all the orientation material including how to deal
with the program’s Ribbon user interface. Of special
interest may be the section selecting commands by touch
if you’re using Excel 2016 on a Windows touchscreen
device that isn’t equipped with either a physical
keyboard or mouse.
Chapter 2 is not to be missed, even if you do not consider
yourself a beginner by any stretch of the imagination.
This chapter covers the many ways to customize Excel
and make the program truly your own. It includes
information on customizing the Quick Access toolbar as
well as great information on how to use and procure add-
in programs that can greatly extend Excel’s considerable
features.

Book II: Worksheet Design



Book II focuses on the crucial issue of designing
worksheets in Excel. Chapter 1 takes up the call on how
to do basic design and covers all the many ways of doing
data entry (a subject that’s been made all the more
exciting with the addition of voice and handwriting
input).
Chapter 2 covers how to make your spreadsheet look
professional and read the way you want it through
formatting. Excel offers you a wide choice of formatting
techniques, from the very simple formatting as a table all
the way to the now very sophisticated and super-easy
conditional formatting.
Chapter 3 takes up the vital subject of how to edit an
existing spreadsheet without disturbing its design or
contents. Editing can be intimidating to the new
spreadsheet user because most spreadsheets contain not
only data entries that you don’t want to mess up but also
formulas that can go haywire if you make the wrong
move.
Chapter 4 looks at the topic of managing the worksheets
that contain the spreadsheet applications that you build
in Excel. It opens the possibility of going beyond the two-
dimensional worksheet with its innumerable columns
and rows by organizing data three-dimensionally through
the use of multiple worksheets. (Each Excel file already
contains three blank worksheets to which you can add
more.) This chapter also shows you how to work with and
organize multiple worksheets given the limited screen
real estate afforded by your monitor and how to combine
data from different files and sheets when needed.
Chapter 5 is all about printing your spreadsheets, a topic
that ranks only second in importance to knowing how to
get the data into a worksheet in the first place. As you
expect, you find out not only how to get the raw data to



spit out of your printer but also how to gussy it up and
make it into a professional report of which anyone would
be proud.

Book III: Formulas and Functions
This book is all about calculations and building the
formulas that do them. Chapter 1 covers formula basics
from doing the simplest addition to building array
formulas and using Excel’s built-in functions courtesy of
the Function Wizard. It also covers how to use different
types of cell references when making formula copies and
how to link formulas that span different worksheets.
Chapter 2 takes up the subject of preventing formula
errors from occurring and, barring that, how to track
them down and eliminate them from the spreadsheet.
This chapter also includes information on circular
references in formulas and how you can sometimes use
them to your advantage.
Chapters 3 through 6 concentrate on how to use
different types of built-in functions. Chapter 3 covers the
use of date and time functions, not only so you know
what day and time it is, but actually put this knowledge
to good use in formulas that calculate elapsed time.
Chapter 4 takes up the financial functions in Excel and
shows you how you can use them to both reveal and
determine the monetary health of your business. Chapter
5 is concerned with math and statistical functions (of
which there are plenty). Chapter 6 introduces you to the
powerful group of lookup, information, and text
functions. Here, you find out how to build formulas that
automate data entry by returning values from a lookup
table, get the lowdown on any cell in the worksheet, and
combine your favorite pieces of text.



Book IV: Worksheet Collaboration
and Review
Book IV looks at the ways you can share your
spreadsheet data with others. Chapter 1 covers the
important issue of security in your spreadsheets. Here,
you find out how you can protect your data so that only
those to whom you give permission can open or make
changes to their contents.
Chapter 2 takes up the subject of building and using
hyperlinks in your Excel spreadsheets (the same kind of
links that you know and love on web pages on the World
Wide Web). This chapter covers how to create hyperlinks
for moving from worksheet to worksheet within the same
Excel file as well as for opening other documents on your
hard drive, or connecting to the Internet and browsing to
a favorite web page.
Chapter 3 introduces Excel’s sophisticated features for
sending out spreadsheets and having a team of people
review and make comments on them. It also covers
techniques for reviewing and reconciling the suggested
changes.
Chapter 4 is concerned with sharing spreadsheet data
with other programs that you use. It looks specifically at
how you can share data with other Office 2016 programs
such as Microsoft Word, PowerPoint, and Outlook. This
chapter also discusses the variety of ways to share your
workbooks files, all the way from inviting people to
review or even edit them from your OneDrive, attaching
them to e-mail and Skype instant messages, and
presenting them in Skype for Business online meetings.

Book V: Charts and Graphics
Book V focuses on the graphical aspects of Excel.
Chapter 1 covers charting your spreadsheet data in some



depth. Here, you find out not only how to create great-
looking charts but also how to select the right type of
chart for the data that you’re representing graphically.
Chapter 2 introduces you to all the other kinds of
graphics that you can have in your spreadsheets. These
include graphic objects that you draw as well as graphic
images that you import, including clip art included in
Microsoft Office, as well as digital pictures and images
imported and created with other hardware and software
connected to your computer.

Book VI: Data Management
Book VI is concerned with the ins and outs of using Excel
to maintain large amounts of data in what are known as
databases or, more commonly, data lists. Chapter 1 gives
you basic information on how to set up a data list and
add your data to it. This chapter also gives you
information on how to reorganize the data list through
sorting and how to total its numerical data with the
Subtotal feature.
Chapter 2 is all about how to filter the data and extract
just the information you want out of it (a process
officially known as querying the data). Here, you find out
how to perform all sorts of filtering operations from the
simplest, which involves relying upon the AutoFilter
feature, to the more complex operations that use custom
filters and specialized database functions. Finally, you
find out how to perform queries on external data sources
such as those maintained with dedicated database
management software for Windows such as Microsoft
Access or dBASE as well as those that run on other
operating systems such as DB2 and Oracle.

Book VII: Data Analysis



Book VII looks at the subject of data analysis with Excel;
essentially how to use the program’s computational
capabilities to project and predict possible future
outcomes. Chapter 1 looks at the various ways to
perform what-if scenarios in Excel. These include
analyses with one- and two-input variable data tables,
doing goal seeking, setting a series of different possible
scenarios, and using the Solver add-in.
Chapter 2 is concerned with the topic of creating special
data summaries called pivot tables that enable you to
analyze large amounts of data in an extremely compact
and modifiable format. Here, you find out how to create
and manipulate pivot tables as well as build pivot charts
that depict the summary information graphically. In
addition, you’ll get an introduction to using the
PowerPivot for Excel 2016 and Power View add-ins to
perform more sophisticated types of data analysis on the
Data Model that’s represented in your Excel pivot table.

Book VIII: Macros and VBA
Book VIII introduces the subject of customizing Excel
through the use of its programming language called
Visual Basic for Applications (VBA for short). Chapter 1
introduces you to the use of the macro recorder to
record tasks that you routinely perform in Excel for later
automated playback. When you use the macro recorder
to record the sequence of routine actions (using the
program’s familiar menus, toolbars, and dialog boxes),
Excel automatically records the sequence in the VBA
programming language.
Chapter 2 introduces you to editing VBA code in Excel’s
programming editor known as the Visual Basic Editor.
Here, you find out how to use the Visual Basic Editor to
edit macros that you’ve recorded that need slight
modifications as well as how to write new macros from



scratch. You also find out how to use the Visual Basic
Editor to write custom functions that perform just the
calculations you need in your Excel spreadsheets.

Conventions Used in This
Book

This book follows a number of different conventions
modeled primarily after those used by Microsoft in its
various online articles and help materials. These
conventions deal primarily with Ribbon command
sequences and shortcut or hot key sequences that you
encounter.
Excel 2016 is a sophisticated program that uses the
Ribbon interface first introduced in Excel 2007. In
Chapter 1, I explain all about this Ribbon interface and
how to get comfortable with its command structure.
Throughout the book, you may find Ribbon command
sequences using the shorthand developed by Microsoft
whereby the name on the tab on the Ribbon and the
command button you select are separated by arrows, as
in

Home    ⇒    Copy

This is shorthand for the Ribbon command that copies
whatever cells or graphics are currently selected to the
Windows Clipboard. It means that you click the Home
tab on the Ribbon (if it’s not already displayed) and then
click the Copy button (that sports the traditional side-by-
side page icon).
Some of the Ribbon command sequences involve not only
selecting a command button on a tab but then also
selecting an item on a drop-down menu. In this case, the



drop-down menu command follows the name of the tab
and command button, all separated by vertical bars, as in

Formulas    ⇒    Calculation Options    ⇒    Manual

This is shorthand for the Ribbon command sequence that
turns on manual recalculation in Excel. It says that you
click the Formulas tab (if it’s not already displayed) and
then click the Calculation Options command button
followed by the Manual drop-down menu option.
The book occasionally encourages you to type something
specific into a specific cell in the worksheet. When I tell
you to enter a specific function, the part you should type
generally appears in bold type. For example,
=SUM(A2:B2) means that you should type exactly what
you see: an equal sign, the word SUM, a left
parenthesis, the text A2:B2 (complete with a colon
between the letter-number combos), and a right
parenthesis. You then, of course, still have to press the
Enter key or click the Enter button on the Formula bar to
make the entry stick.
When Excel isn’t talking to you by popping up message
boxes, it displays highly informative messages in the
status bar at the bottom of the screen. This book renders
messages that you see onscreen like this:

CALCULATE

This is the message that tells you that Excel is in manual
recalculation mode (after using the earlier Ribbon
command sequence) and that one or more of the
formulas in your worksheet are not up to date and are in
sore need of recalculation.
Occasionally I give you a hot key combination that you
can press in order to choose a command from the



keyboard rather than clicking buttons on the Ribbon with
the mouse. Hot key combinations are written like this:
Alt+FS or Ctrl+S. (Both of these hot key combos save
workbook changes.)
With the Alt key combos, you press the Alt key until the
hot key letters appear in little squares all along the
Ribbon. At that point, you can release the Alt key and
start typing the hot key letters. (By the way, you type all
lowercase hot key letters — I only put them in caps to
make them stand out in the text.)
Hot key combos that use the Ctrl key are of an older
vintage, and they work a little bit differently because, on
a physical keyboard, you have to hold down the Ctrl key
as you type the hot key letter. (Again, type only
lowercase letters unless you see the Shift key in the
sequence as in Ctrl+Shift+C.)
Finally, if you’re really observant, you may notice a
discrepancy between the capitalization of the names of
dialog box options (such as headings, option buttons, and
check boxes) as they appear in the book and how they
actually appear in Excel on your computer screen. I
intentionally use the convention of capitalizing the initial
letters of all the main words of a dialog box option to
help you differentiate the name of the option from the
rest of the text describing its use.

Icons Used in This Book
The following icons are strategically placed in the
margins throughout all eight books in this volume. Their
purpose is to get your attention, and each has its own
way of doing that.



 This icon denotes some really cool information (in
my humble opinion) that will pay off by making your
work a lot more enjoyable or productive (or both).

 This icon denotes a tidbit that you ought to pay
extra attention to; otherwise, you may end up taking
a detour that wastes valuable time.

 This icon denotes a tidbit that you ought to pay
extra attention to; otherwise, you’ll be sorry. I
reserve this icon for those times when you can lose
data and otherwise screw up your spreadsheet.

 This icon denotes a tidbit only for Excel users who
are running Excel 2016 on some sort of touchscreen
device such as a Windows tablet.

 This icon denotes a tidbit that makes free use of
(oh no!) technical jargon. You may want to skip these
sections (or, at least, read them when no one else is
around).

Where to Go from Here
The question of where to go from here couldn’t be
simpler, go to Chapter 1 and find out what you’re dealing
with. Which book you go to after that is a matter of
personal interest and need. Just go for the gold and don’t
forget to have some fun while you’re digging!



 Occasionally, Wiley’s technology books are
updated. If this book has technical updates, they’ll be
posted at www.dummies.com/go/excel2016aioupdates.

http://www.dummies.com/go/excel2016aioupdates


Book I
Excel Basics

 Visit www.dummies.com for great Dummies content
online.

http://www.dummies.com/
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Chapter 1
The Excel 2016 User

Experience
In This Chapter

 Getting to know Excel 2016’s Start screen and
program window

 Selecting commands from the Ribbon
 Unpinning the Ribbon
 Using Excel 2016 on a touchscreen device
 Getting around the worksheet and workbook
 Using Excel 2016’s new Tell Me feature when

you need help
 Launching and quitting Excel

Excel 2016 relies primarily on the onscreen element
called the Ribbon, which is the means by which you
select the vast majority of Excel commands. In addition,
Excel 2016 sports a single toolbar (the Quick Access
toolbar), some context-sensitive buttons and command
bars in the form of the Quick Analysis tool and mini-bar,
along with a number of task panes (such as Clipboard,
Research, Thesaurus, and Selection to name a few).
Among the features supported when selecting certain
style and formatting commands is the Live Preview,
which shows you how your actual worksheet data will
appear in a particular font, table formatting, and so on
before you actually apply it. Excel also supports an
honest-to-goodness Page Layout view that displays rulers



and margins along with headers and footers for every
worksheet. Page Layout view has a zoom slider at the
bottom of the screen that enables you to zoom in and out
on the spreadsheet data instantly. The Backstage view
attached to the File tab on the Excel Ribbon enables you
to get at-a-glance information about your spreadsheet
files as well as save, share, preview, and print them. Last
but not least, Excel 2016 is full of pop-up galleries that
make spreadsheet formatting and charting a real breeze,
especially with the program’s Live Preview.

Excel 2016’s Sleek Look
and Feel

If you’re coming to Excel 2016 from Excel 2007 or Excel
2010, the first thing you notice about the Excel 2016
user interface is its comparatively flat (as though you’ve
gone from 3-D to 2-D) and decidedly less colorful display.
Gone entirely are the contoured command buttons and
color-filled Ribbon and pull-down menu graphics along
with any hint of the gradients and shading so prevalent
in the earlier versions. The Excel 2016 screen is so stark
that even its worksheet column and row borders lack any
color, and the shading is reserved for only the columns
and rows that are currently selected in the worksheet
itself.
The look and feel for Excel 2016 (indeed, all the Office
2016 apps) is all part of the Windows 10 user experience.
This latest version of the Windows operating system was
developed primarily to work across a wide variety of
devices from desktop and laptop to tablets and
smartphones, devices with much smaller screen sizes
and where touch often is the means of selecting and
manipulating screen objects. With an eye toward making



this touch experience as satisfying as possible on all
these devices, Microsoft redesigned the interface of both
its new operating system and Office 2016 application
programs: It attempted to reduce the graphical
complexity of many screen elements as well as make
them as responsive as possible on touchscreen devices.
The result is a snappy Excel 2016, regardless of what
kind of hardware you run it on. And the new, somewhat
plainer and definitely flatter look, while adding to Excel
2016’s robustness on any device, takes nothing away
from the program’s functionality.

 The greatest thing about the look of Office 2016 is
that each of its application programs features a
different predominant color. Excel 2016 features a
green color long associated with the program. Green
appears throughout the program’s colored screen
elements, including the Excel program and file icon,
the status bar, the outline of the cell pointer, the
shading of highlighted and selected Ribbon tabs, and
menu items. This is in stark contrast to the last few
versions of Excel where the screen elements were all
predominately blue, the color traditionally associated
with Microsoft Word.

Excel’s Start Screen
When you first launch Excel 2016, the program opens up
an Excel Start screen similar to the one shown in Figure
1-1. This screen is divided into two panes. The left pane
lists recently opened workbooks and contains an Open
Other Workbooks link. The right pane contains a Search
for Online Templates text box with links to suggested
searches (Business, Personal, Industry, and so on)



followed by your user account name, e-mail, and photo, if
you use one. Below you see thumbnails of various
different templates that you can use in opening a new
Excel workbook file.

Figure 1-1: The Excel 2016 program window as it appears immediately after
launching the program.

The first template thumbnail displayed here is called
Blank Workbook, and you select this thumbnail to start a
new spreadsheet of your own design. The second
thumbnail is called Take a Tour, and you select this
thumbnail to open a workbook with five worksheets that
enable you to play around with several of the nifty new
features in Excel 2016.



 I encourage you to take the time to open the Take
a Tour template and explore its worksheets. When
you click this thumbnail, Excel opens a new Welcome
to Excel workbook where you can experiment with
using the Flash Fill feature to fill in a series of data
entries; the Quick Analysis tool to preview the
formatting, charts, totals, pivot tables, and
sparklines you can add to a table of data; and the
Recommended Charts command to create a new
chart, all with a minimum of effort. After you’re done
experimenting with these features, you can close the
workbook by choosing File    ⇒    Close or pressing
Ctrl+W and then clicking the Don’t Save button in
the alert dialog box that asks you whether you want
to save your changes.

Following the Blank Workbook and Take a Tour template
thumbnails, you find all sorts of standard templates that
you can select to use as the basis for new worksheets.
These templates run the gamut from invoicing
spreadsheets to a sales call log and organizer. (See Book
II, Chapter 1 for more on creating new workbooks from
ready-made and custom templates.)

Excel’s Ribbon User
Interface

When you first open a new, blank workbook, Excel 2016
opens up a single worksheet (with the generic name,
Sheet1) in a new workbook file (with the generic
filename, Book1) inside a program window such as the
one shown in Figure 1-2.



Figure 1-2: The Excel 2016 program window as it appears after first opening a
blank workbook when both Ribbon tabs and commands are displayed.

The Excel program window containing this worksheet of
the workbook is made up of the following components:

File tab: When clicked, this tab opens the Backstage
view, which contains a bunch of file-related options
including Info, New, Open, Save, Save As, Print, Share,
Export, Publish, Close, and Account, as well as Options,
which enables you to change Excel’s default settings.
Quick Access toolbar: You can click the Save, Undo,
and Redo buttons to perform common tasks to save



your work and undo and redo editing changes. You can
also click the Customize Quick Access Toolbar button
to the immediate right of the Redo button to open a
drop-down menu containing additional common
commands such as New, Open, Quick Print, and so on,
as well as to customize the toolbar, change its
position, and minimize the Ribbon.
Ribbon: Most Excel commands are contained on the
Ribbon. They are arranged into a series of tabs ranging
from Home through View.
Formula bar: This displays the address of the current
cell along with the contents of that cell.
Worksheet area: This area contains all the cells of
the current worksheet identified by column headings,
which use letters along the top, and row headings,
which use numbers along the left edge, with tabs for
selecting new worksheets. You use a horizontal scroll
bar on the bottom to move left and right through the
sheet and a vertical scroll bar on the right edge to
move up and down through the sheet.
Status bar: This bar keeps you informed of the
program’s current mode and any special keys you
engage, and it enables you to select a new worksheet
view and to zoom in and out on the worksheet.



 When using Excel 2016 on a touchscreen device,
the Ribbon Display Options are automatically set to
Tabs (so that associated commands appear only
when you tap a tab) and the Quick Access toolbar
contains a Touch/Mouse Mode button. Tap this
button followed by the Touch option on its drop-down
menu to spread out the tabs and their command
buttons on the Ribbon. That way you have a fighting
chance of correctly selecting them with your finger
or stylus. On a touchscreen tablet such as the
Microsoft Surface 3 tablet, an Ink Tools tab where
you can modify settings for using a stylus follows the
View tab.

Going behind the scenes to Excel’s
Backstage view
At the top of the Excel 2016 program window,
immediately below the Excel program button and the
Save button on the Quick Access toolbar, you find the
File menu button (the green one with “File” in white
letters to the immediate left of the Home tab).
When you click the File menu button, the Excel
Backstage view appears. The screen in this view contains
a menu of file-related options running down a column on
the left side and, depending upon which option is
selected, some panels containing both at-a-glance
information and further command options.

 At first glance, the File menu button may appear
to you like a Ribbon tab — especially in light of its
rectangular shape and location immediately left of
the Ribbon’s initial Home tab. Keep in mind,



however, that this important file control is technically
a command button that, when clicked, leads directly
to a totally new, nonworksheet screen with the
Backstage view. This screen has its own menu
options but contains no Ribbon command buttons
whatsoever.

 After you click the File menu button to switch to
the Backstage view, you can then select the Back
button (with the left-pointing arrow) that appears
above the Info menu item to return to the normal
worksheet view or you can simply press the Esc key.

Getting the lowdown on the Info screen
When you choose File    ⇒    Info at the top of File menu in
the Backstage view, an Info screen similar to the one
shown in Figure 1-3 appears.



Figure 1-3: The Excel Backstage view displaying the Info screen with
permissions, distribution, version commands, and more.

On the left side of this Info screen, you find the following
four command buttons:

Protect Workbook to encrypt the Excel workbook file
with a password, protect its contents, or verify the
contents of the file with a digital signature (see Book
IV, Chapters 1 and 3 for more on protecting and
signing your workbooks)
Inspect Workbook to inspect the document for
hidden metadata (data about the file) and check the
file’s accessibility for folks with disabilities and
compatibility with earlier versions of Excel (see Book
IV, Chapter 3 for details on using this feature)



Manage Workbook to recover or delete draft
versions saved with Excel’s AutoRecover feature (see
Book II, Chapter 1 for more on using AutoRecover)
Browser View Options to control what parts of the
Excel workbook can be viewed and edited by users
who view it online on the Web

On the right side of the Info screen, you see a list of
various and sundry bits of information about the file:

Properties lists the Size of the file as well as any Title,
Tags, and Categories (to help identify the file when
doing a search for the workbook) assigned to it. To edit
or add to the Title, Tags, or Categories properties, click
the appropriate text box and begin typing. To add or
change additional file properties, including the
Company, Comments, and Status properties, click the
Properties drop-down button and then select Show
Document Panel or Advanced Properties from its drop-
down menu. Select Show Document Panel to open the
Document panel in the regular worksheet window
where you can edit properties such as Author, Title,
Subject, and Keywords and to add comments. Select
the Advanced Properties option to open the
workbook’s Properties dialog box (with its General,
Summary, Statistics, Contents, and Custom tabs) to
change and review a ton of file properties.
Related Dates lists the date the file was Last
Modified, Created, and Printed.
Related People lists the name of the workbook’s
author as well as the name of the person who last
modified the file. To add an author to the workbook
file, click the Add an Author link that appears beneath
the name of the current author. If the workbook file is



new and you’ve never saved it on disk, the words “Not
Saved Yet” appear after Last Modified By.
The Open File Location check box appears under
the Related Documents heading. Select it to open the
folder containing the current workbook file, where you
can find associated workbook files to work with.
The Show All Properties link, when clicked,
expands the list of Properties to include text fields for
Comments, Template, Status, Categories, Subject,
Hyperlink Base, and Company that you can edit.

Sizing up other File menu options
Immediately below the Info option at the very top of the
File menu, you find the commands you commonly need
for working with Excel workbook files, such as creating
new workbook files as well as opening, saving, and
closing files. (See Book II, Chapter 1 for more on saving
and closing files and Book II, Chapter 3 for more on
opening them.)
The New command immediately below Info displays a
New screen, which, just like the Excel Start screen,
displays a thumbnail list of all the available spreadsheet
templates. (See Book II, Chapter 1 for more on creating
and using workbook templates.)
Beneath the Save As command you find the Print option
that, when selected, displays a Print screen. This screen
contains the document’s current print settings (that you
can modify) on the left side and a preview area that
shows you the pages of the printed worksheet report.
(See Book II, Chapter 5 for more on printing worksheets
using the Print Settings panel in the Backstage view.)
Below the Print command you find the Share option,
which displays a list of commands for sharing your
workbook files online. Beneath this, you find an Export


